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Introduction 
 

This is a guide for those who would like to learn how to start a website. 
Since you’re reading this, you probably already know how important it is for 
any company or self employed contractor to have a web presence. When 
you know how to create your own website, you can make a personal 
website showcasing your hobbies, family photos, selling your own 
products, or anything else you can dream up. 

However, that is getting far ahead of ourselves. This guide is not about how 
to sell products, get more traffic to your site, or even how to design a 
website. This guide is only about how to start a website – how to register a 
domain name, sign up with a hosting company, create simple web pages 
with HTML, and get them on the internet. 

Since this is for the complete novice, the first section is an overview of 
basic terms, explained in a way that’s easy to understand. If you truly are a 
novice at website creation, you may have already read some terms here 
that you aren’t familiar with. Not to worry. Everything that you need to 
understand will be explained. 

Each step is illustrated with diagrams so that you can follow along easily. 
When diagrams are not possible, you will have to forge ahead on your own 
a little. For that reason, you should feel fairly comfortable with using a 
computer and the internet. But again, prior knowledge about how to create 
a website is not necessary. 

After you’ve gone through this process once, you’ll wonder why it seemed 
so mysterious and difficult before. 

Let’s jump right in. 
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Basic Terms 
 

Domain 

A website’s domain is the “something.com”. For example, 
howtostartawebsite-forbeginners.com or google.com or yahoo.com. The 
same goes for .org or .net sites, such as craigslist.org. 

Domain Registration 

In order for you to own a domain, you have to register it. The process for 
this will be explained in the next chapter. Once you register a domain it is 
reserved for you and nobody else can register it. 

FTP 

FTP stands for File Transfer Protocol. It is a common method used for 
transferring your web page files from your computer to your hosting 
company’s server. This is what allows the web pages you created on your 
computer to show up on the internet. It’s simple and easy, and 
accomplished by using a small, free program. Instructions for this will be 
provided later on. 

Hosting Company 

Every website has to be hosted on a server. You can do this yourself but 
it’s far easier and inexpensive to pay for hosting services at a hosting 
company. The hosting company has servers that store your web pages. 
When you or anyone else views your website, you’re seeing files that are 
being stored on those servers. 

HTML 

HTML stands for Hypertext Transfer Markup Language. It is the most basic 
programming language in which websites are created. There are many 
other languages that can be used for website creation, but they are not 
required in order to create useable designs. You don’t even have to know 
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HTML in order to create a web page because you can use website creation 
software to do it for you. More about that will be explained later. 

Notepad 

Notepad is a simple text editor found on all Windows computers. Similar 
programs are on Mac and Linux-based computers. You can actually create 
web pages in a program like this, and you’re going to learn how in the 
pages ahead. 

Server 

A server is like a specialized computer that is set up specifically for storing 
web pages and other files for use on the internet. 

Web Design Software 

There are many different programs that you can use to create your web 
pages. Many of them operate similarly to a word processing program, such 
as Microsoft Word. Some web design programs have to be purchased and 
some are free. These programs allow you to create websites as easily as 
creating a document in Microsoft Word because they generate the HTML in 
the background for you. 

WYSIWYG 

WYSIWYG stands for What You See Is What You Get. This is a common 
acronym used to describe programs that allow you create web pages 
visually. What you see as you create the web page is what you get when 
it’s live on the internet. 

URL 

URL stands for Uniform Resource Locator. In simpler language, it’s a 
website address, such as www.google.com or news.google.com or 
www.google.com/news 
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Signing Up For Website Hosting 
 

Over the years I have used many different hosting companies, and my 
favorite, by far, is DreamHost. You can certainly use a different company, 
but since I use them myself and I’m recommending them to you, all of the 
instructions and diagrams in this book refer to the usage of DreamHost. 

DreamHost has allowed me to offer you two special discounts! 

When you sign up with DreamHost, you’ll get 15% off hosting fees. This 
applies whether you choose to pay monthly, yearly, or for two years in 
advance. 

You’ll also get one FREE domain registration! This is a $10 value. 

To get these two awesome discounts, all you have to do is enter the promo 
code STARTASITE when you sign up with DreamHost. 

Follow the instructions below to get started. 
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Step 1: Go to DreamHost.com and click on “Sign Up Now” (the yellow 
starburst image) 
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Step 2: Begin the signup process. Just enter the information requested on 
the form with your current email address and any password that you would 
like to use. 
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Step 3: Pick a Domain 

You already get to choose your own domain! Select the first option for 
“Register a new .com/net/org/info domain for me.” 

After Domain: www type in whatever you want your domain to be. 

The domain you type in might be already be in use on the internet. If that is 
the case, DreamHost will notify you and allow you to choose a different 
one. 

Three important tips for domain names: 

• Choose something original 

• Choose something that succinctly sums up your website 

• Try to choose something easy to type and remember 
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Step 4: Just a little more … 

Pick First Server Username: This can be any username that you’d like. 
It’s nothing magical. 

In what city were you born? The answer to this will be requested from 
you if you later forget your password, so be honest and type something that 
you’ll remember. 

How did you first hear about us? If you like, you can put 
howtostartawebsite-forbeginners.com 

Promotional code: Type STARTASITE to get your free domain 
registration and 15% off hosting fees. 
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Next Steps: On Your Own 

I can’t give you any images farther than this because I already have an 
account with them. In a nutshell, you’ll be asked to choose whether you 
want to pay for hosting monthly or yearly (I recommend yearly). Then you’ll 
be asked for payment information. Just follow the on-screen instructions 
and it will be self-explanatory enough. 

Once you’ve completed your signup process, you’ll get a welcome email 
from DreamHost with more information about your account. 

When you sign in to your DreamHost account, you should see a screen 
that looks like: 

This is the main DreamHost Control Panel page. You can do just about 
anything you need from here, including: manage your website hosting 
account, add email addresses, manage users, and register more domain 
names. 
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Fully Host Your Website 
 

When you signed up at DreamHost, or if you register a domain later, you 
can choose to “Park” your domain, or you can choose to “Fully Host” it. 

In order to start creating your website, it has to be fully hosted. You can do 
this now or later. It doesn’t have to be done immediately, but it has to be 
done before you can post any web pages online. 

If you already chose to Fully Host your website, then you can skip this step. 
If you chose to Park it, follow along. If you’re not sure, go ahead and follow 
along and you’ll find out where you stand. 

 

Step 1: Go to the main DreamHost page and click on Website Hosting 
(right under “Let’s Get Started!”) 
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Step 2: Find your domain and see if it is parked or hosted. 

If it looks like this, then it is Parked: 

 

Note the “parked” under “Web Hosting”. 

 

When you’re ready to have your site fully hosted, click on Edit. 
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Step 3: For “Do you want the www in your URL?” I recommend choosing 
the second option. 

You don’t have to change anything else on this page. 

 

 

Scroll down until you see the information shown on the next page.
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Step 4: Here you have the option of setting up a couple services with 
Google. 

 

You can use Gmail for your primary email account at this domain. I like to 
use the actual domain name in my email address, such as 
bonnie@howtostartawebsite-forbeginners.com, and I’ll show you how to do 
that later. 

You can also set up a Google calendar if you wish. I don’t usually do this, 
but if you think it would be useful for your particular website, go right ahead. 

When you’re finished with that, click “Fully Host This Domain”. 
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On the next page you should get something like this: 

 

Your domain is now Fully Hosted and ready for action. 
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How To Register A New Domain
 

If you followed the steps above, you should already have a registered 
domain name. If you’re interested in registering an additional domain name, 
now or later, DreamHost makes it easy. 

Go to the Registrations page and you’ll see a screen that looks like this: 

 

Where it says “Domain to Register:” type in the domain name that you’d 
like to register, then click “Check Availability”. DreamHost will check on 
whether the domain is available for use. If it is not available you’ll be 
notified and you can try a different name. 

- 19 - 

https://panel.dreamhost.com/index.cgi?tree=domain.registration


If the domain name is available, you’ll be taken to a page that looks like 
this: 

 

 

It should automatically fill everything in for you. You don’t have to change 
anything at all on this page. 
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At the bottom, click the Continue button. 

 

 

The rest is of the process involves paying for the registration. It’s usually 
$9.95 per year. 

New domains can take up to 48 hours to become active, no matter where 
you register them. I have always seen them become active within a couple 
hours, though. 
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Create An Email Address
 

Now that you have your own domain name, you might want to set up an 
email address for that domain. For example, if your domain name is 
whatever.com you might like an email address such as 
john@whatever.com. 

 

In DreamHost, go to the Email page and you’ll see a screen like this: 

 

This particular screen shows some of the domain names that I have 
registered with DreamHost. At this point, I have no email addresses set up 
for the domain howtostartawebsite-forbeginners.com. 

Click “Create New Email Address”. 
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Email Address: if you want to create john@whatever.com, then you’d 
enter john in this box. If you have more than one domain name, select the 
domain you want to use in the box directly to the right. 

Mailbox “Name”: Type your full name, such as John Brown, or the name 
of your company/website, such as John Brown’s Happy Teddy Bears. 

Pick a password for me: If you want DreamHost to generate a password 
for you, click this box. If you want to choose your own password, leave this 
box empty. 

Password: If you’re choosing your own password, type it in here. 

Leave the rest of this screen as it is and scroll down. 
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You can pretty much leave all of this exactly how it already is, unless you 
personally want to adjust something. 

When you’re finished, click “Create Address”. 
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If everything was successful with the creation of your new email address, 
you’ll see a screen like this: 

 

 

You can use your new email address in any email program like Outlook or 
Outlook Express. 

I will take you through the process of setting up your email address in 
Outlook. You can also get a ton of extra information in DreamHost’s 
support Wiki. 
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Use Your Email Address In Outlook 
 

The email address you created can be used in any email program. Since 
Outlook is a very commonly used email program and I use it myself, that’s 
what these instructions will be for. If you use a different program you can 
probably learn enough here to set up your email address in that program 
too. 

I’m using Outlook 2007. Any other version will be similar but not exactly the 
same. 

Step 1: Open Outlook and go to Tools > Account Settings 
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Step 2: On the Email tab, click New … 
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Step 3: Choose Email Service. 

Select the top option and click Next. 
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Step 4: Add New Email Account 

Don’t fill anything in. Check the box near the bottom for “Manually select 
server settings or additional server types” and click Next. 

 

- 29 - 



Step 5: Choose Email Service. Select the top option and click Next. 
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Step 6: Internet Email Settings 

 

Your name: Type your name as you would like it to appear when people 
get an email from you. 

Email address: Enter your whole email address. In this example I’m using 
bonnie@howtostartawebsite-forbeginners.com

Incoming Mail Server and Outgoing mail server (SMTP): 
Type “mail” followed by your domain name. In this example I’m using 
mail.howtostartawebsite-forbeginners.com 

Username: Enter your whole email address. 

Password: Enter your password 

When you’re finished with all of that, click the “More Settings …” button. 
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Step 7: Click the “Outgoing Server” tab. 

Check the box that says “My outgoing server (SMTP) requires 
authentication.” 

Click the OK button. 
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Step 8: Now you’re back at the previous screen: 

 

Click the button that says “Test Account Settings …” This will test all of 
your settings. Upon success you’ll get a screen that looks like this: 
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On that screen, click Close. On the leftover screen, click Next. 

That will take you to this: 

 

 

 

Click Finish. 

You’re done! You can now send a receive emails in Outlook. 
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Web Pages Are Simple 
 

Despite what you might think right now, web pages really are simple. They 
can be very complicated too, of course, but not all of them are. 

I would like you to do this little exercise. It will help you get over any fear 
related to HTML and making web pages. You’ll learn the most basic HTML 
that’s required for a web page and how to make your own little web page in 
Notepad (or any similar text editor). We’ll use the web page you create later 
on when learning how to work with FTP. 

 

Step 1: Open Notepad or your text editor of choice. 

On my computer Notepad can be found under Start Menu > Accessories > 
Notepad. 

Step 2: After you open Notepad, go to File > Save As 
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Step 3: Save the file as hello.htm on your Desktop. Just type hello.htm as 
the filename. 
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Step 3: Some Basic HTML 

This is what your work space looks like: 

 

The very first thing to do is declare that this is an HTML web page. You 
define this with HTML “tags”. Anything in HTML that is enclosed with carrot 
characters is a “tag”. It looks like this: 

<html> 

</html> 

Every tag has a “closing tag” which is created with the slash character. This 
effectively signals the end of the tag. In this case, it shows that all of the 
HTML is now at an end. 

 

- 37 - 



The first part of every HTML web page is the Head. You define this with 
Head “tags”.  

<head> 

</head> 

The slash character denotes the end of the Head tag, signaling the end of 
the Head part of the web page. The head tags go between the HTML tags. 
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Inside the Head tags, you should have a Title tag. This tells the browser 
what to display for the title of the web page, and it goes between the Head 
tags. It looks like this: 

<title> </title> 

The Title of your web page will be “Hello!” 

<title>Hello!</title> 

 

 

 

For now, that’s all you need for your Head section. 
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Next is the Body of the web page. That’s where everything that actually 
appears on your web page is created. This goes after the </head> tag, but 
before the </html> tag. 

It looks like this: 

<body> 

</body> 
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Next we’ll put a simple message between the Body tags that will appear on 
your webpage. 

First we should declare that we’re going to be using a paragraph of text. 
You can do this with Paragraph tags. It looks like this: 

<p> </p> 

We can write a sentence between those Paragraph tags. Let’s write, “Hello, 
world!” 

 

 

Important: Save your file right now. Go to File > Save. 

This is all you need for a very simple webpage. Now you can view it in a 
browser to see what you’ve created. 
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Step 4: See your web page 

Open up a browser. I’ll show the process with Internet Explorer, but it will 
be very similar with any other browser. 

 

First, go to File > Open 
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Click the Browse button 

 

Find hello.htm on your computer. If you saved it to your Desktop as 
instructed, that’s where it will be. 
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Click the OK button 

 

Now you see your web page: 

 

 

Congratulations! You’ve created a real web page. It’s not on the internet 
yet, but it’s still a web page and it was written in HTML. You could even say 
that you programmed it. 
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How To Use FTP 
 

FTP (File Transfer Protocol) is a simple method of transferring files from 
your computer to the server that hosts your website. It’s an easy way for 
you to get your pages on the internet. 

I use a little program called FTP Explorer. It’s free and you can download it 
from my website. 

 

Step 1: Download FTP Explorer

It comes as a .zip file, so after you download it you’ll need to unzip it with a 
program like WinZip or ZipGenius. 

After you’ve unzipped the file you can install the program by double-clicking 
Setup.exe. Follow the on-screen instructions. 

 

You can use any other FTP program but the example images shown here 
will be for FTP Explorer. 
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Step 2: Check on / modify your FTP account information. 

Login to your DreamHost account and click on Users then Manage Users. 
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This will bring you to a page like this: 

The important bits of information you need from this screen are the user 
information and the password. 

Near the top in my example it says: 

Editing User: aragornrain (on bonanno) 

“aragornrain” is my username and “bonanno” is the name of my server. 
Your screen will show your username and server. Write these down for 
future reference. You’ll need it soon. 

A bit farther down the page, you can enter a new password. This password 
will only be used for your FTP access and won’t change the password you 
use for logging into your main DreamHost account.  

If you already know what this password is, leave it. Otherwise, update it. 
Write the down the password – you’ll need it soon, too. 
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Step 3: Set up FTP Explorer 

When you first open FTP Explorer, you should get a screen that looks fairly 
blank. Click the button circled in this image: 

 

 

This button is “Connect” which will bring up a screen that will allow you to 
connect to your server. 
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You will have a list of sample profiles on the left side. You can choose any 
one of them to modify. 

Profile Name: I call this “dreamhost websites” because it is where I access 
all of the websites that I have hosted with DreamHost. You can call it 
anything you want. 

Host Address: This is where you use the information you wrote down 
earlier. In my example, I have bonanno.dreamhost.com because that’s my 
server name. Yours is different. This is the information you got from the 
“Manage Users” screen before. 

Login: This is your username. In my example, it’s “aragornrain”. Again, you 
got this information from the “Manage Users” screen. 

Password: Enter your FTP password. 
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Click Connect. If you’ve entered everything correctly, you’ll be logged in. 
You’ll see some folders like this: 

 

 

Double-click on the folder that has the name of your website. In this 
example, it’s “howtostartawebsite-forbeginners.com”. 
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You should now see a screen that looks like this: 

 

Now you can put the web page you made on the internet, so that it’s 
actually part of your website. 

First, click the button with the Up arrow that’s circled in this illustration. That 
button is for “Upload”. 

 

Quick terminology: 

When you download a file, you are transferring it from a server to your 
computer. 

When you upload a file, you are transferring it from your computer to a 
server. 
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After you click the Upload button you’ll see a screen where you can 
browser your computer to find the file that you want to upload. 

If your hello.htm file is still on your Desktop, that’s where you’ll find it. 

 

 

Once you’ve found hello.htm and selected it, click Open. 

Now you can go see it on the internet! 
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Step 4: Go see your web page 

Go back to Internet Explorer or the browser of your choice. 

In the address bar, type your domain name followed with a slash then 
hello.htm, like this: 

http://www.howtostartawebsite-forbeginners.com/hello.htm

 

 

 

Your web page is now online and available for anyone to see. 

If you’ve made it this far, I want to give you a big congratulations! If 
you were a complete beginner at website creation, you’ve learned a lot and 
you now have your own functioning website. I hope that everything went 
smoothly for you. 

The next step is to start putting together your website. That is definitely 
another topic and it won’t be covered in this book, but I’ll give you a bit of 
information on how to get started in the next chapter. 
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Web Design Software 
 

Since you’re new to website creation, I recommend using a WYSIWYG 
editor (What You See Is What You Get). That will allow you to create web 
pages without having to learn HTML any further than you already have. 
They also have a way for you to view the HTML at any time, and you can 
use that to make your own edits or adjustments. 

If you type “web design software” into Google you’ll find a lot of choices for 
different programs to use. Below are a few popular examples. 

Paid Software 

If you want to buy a web design program, there are two that are commonly 
used: 

Microsoft FrontPage

Adobe Dreamweaver

Many people will argue for one or the other as strongly as if they were 
discussing Ford or Chevy. In my opinion, you should use the one you like 
best. If you’re already familiar with Microsoft software or Adobe software 
you can expect the same kind of functionality from these programs. 

Coffee Cup is another good option, and much cheaper at $49. 

Free Software 

There is a lot of free software out there. Again, type “free web design 
software” into Google and have a field day. 

The one I recommend is Nvu, which you can find at http://net2.com/nvu/

The great thing about free software is that you can try a few of them and 
see what you like best. 
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Getting Support 
 

DreamHost’s Wiki 

If you have any questions about the hosting services at DreamHost, they 
have an extensive help section at wiki.dreamhost.com. That should be 
your main go-to place for any technical questions or general support 
related to hosting, domains, your email addresses, and billing. 

Learning HTML 

If you’re interested in learning HTML, a great place to start is HTML.net. 

Learning Web Design 

In my opinion, the best way to learn how to design a website is to just start 
doing it. If you’ve got a WYSIWYG web page editor, just play around with it 
and see what you can do. It’s no more difficult than making a document in 
Microsoft Word. 

Hiring Help 

I offer a web design and SEO (search engine optimization) service. I’m 
based in Portland, OR, but I can easily work through email and on the 
phone. 

Projects are priced on a case-by-case basis, but after I speak with you I’ll 
give you an estimate. Find out more at Bonnie Martin SEO. 

There are likely plenty of web design contractors in your area that you 
could look up as well. Make sure the person gives you a solid idea of what 
he or she can do for you, and how much it will probably cost. 
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About the Author 
 

I have been working in the field of web design for nearly ten years. I run the 
daily workings of www.ebookmall.com, including design and graphics, 
publishing options, product management, and the management of tech 
support. 

I have a website consulting service at www.bonniemartinseo.com where I 
contract out my web design and SEO work to individuals and small 
companies. 

I am also involved in fitness and weight loss, and I’m building a weight loss 
resource website at www.skinny-pig-weight-loss.com. 

In my spare time I enjoy photography, biking through the city, dog walks, 
the occasional video game, and watching the Discovery Channel. I also 
love reading or watching almost anything related to Science Fiction or 
Fantasy. 

I grew up in Northern California and now reside in Portland, OR with my 
Toy Poodle, Kiki. 

If you have questions about this book, contact me directly at 
bonnie@howtostartawebsite-forbeginners.com. 

If you’d like to discuss my web design or SEO service, you can use 
bonnie@bonniemartinseo.com. 
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